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Amazon.com Lists 2,062
Point—-and-Shoot Cameras

771 cost $100-$200




A digital camera, dollar for
dollar, is the most powerful
telehealth peripheral

Especially true for remote and developing
regions. It is a ubiquitous consumer device
that virtually anyone can operate.




Digital Cameras:

A Consumer Product

» Global demand for digital
cameras to reach 111
million units in 2008

- US digital camera market to
reach 40 million in 2008

» Digital camera sales up
20%, revenues up 3%

» 67% of US households had
digital cameras in 2006

» Film sales drop by 20%
every year

AFHCAN'

» 90% of all professional

photos taken in 2010 will
be digital

15% of digital camera
ownhers never delete any
images

11% of Americans have
more than 10,000 digital
photos

80% of cameraphone
owners also carry their
digital camera
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How do | select a camera?

J.D. Power and Associates

2008 Digital Camera Usage and Satisfaction Study*" » H Ig hest Rati ng7
Customer Satisfaction Index Ranking > “The FU_]|f||m Finepix S series
Pojntanthmtseg7,ent p I.“:."\T.";“;" - ran ks highest in t e point .and
i e o s comsumers shoot segment ... performing
lmd‘nlmhncpleScnes: B 77777 A _____ ‘.,.. 77777 ‘>'5f ) part[CUIarly Well In plctu re
Koamv seres | quality, performance and ease
Knﬁak!S-ene; ! -‘f]1 Of Operatlon.”
pA o » Market Leader?
Sompcysersmatssenes [ |m > “Canon held onto the lead in
Samung s seves | market share for the third _
Nikon Coolpixtife(Series | | 714 consecutive year with 23%’ while
Poinl and Shool Segment Average _111
Ium:x(l’:uom:ﬂllclfﬁcllt‘i I -.'10 Sony had an ] 8% Share’ and
KodakC.Scnu '.'us KOdak had ] 6%'
Polaroid | Series I :lDb
Fufilm Finepox & Series 704 } Brand onalty?
— - “349% of US digital camera
e L owners are repeat digital
: | camera buyers .”
. » Megapixels

» Pre-sales information?
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Marketing Strategies

ind the

nerfecticamera;: s
z00u o

» MegaPixels (MP)

o Most telehealth is

conducted using 0.3
MP

—

~a

» Gorgeous Outdoor

h .
Shots » Compact Size
> Fluorescent or

Incandescent Lighting > Stolen - Lost - Misplaced -

Dropped
» Awesome Battery Life , Scene Modes, Face
- Average Number of Detecti Digital Z
Pictures/Encounter: 3 etection, Ligital oom

- May not apply
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Our Approach

» BUDGET

> Determine how much you are willing to spend

/" » ESTABLISH REQUIREMENTS N

> e.g. Power System, Docking station, Macro

» MARKET REVIEW, LEARN, RESEARCH

> Hit web pages, reviews, visit stores

» PURCHASE, BEG, BORROW or SFEAL TEST UNITS
- Cameras with closed match to requirements
» TEST
\\ - e.g. Image Quality, UAT, Integration /
» PRODUCTION

> Volume Purchase, Integrate, Curriculum, Assembly, Ship,
Train, Support.
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Source: Long, B., Complete Digital Photography, (c) 2007. ’k{?f ’Jz
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Note...

Clinical (Telehealth) Images are
Different from Consumer Images

Skin tones
Wet surfaces
Tight spaces

Corner cases
> Microscope
o X-rays

Motion Artifact

» Target of Interest
» Provide Perspective

» Multiple image of same
subject - close / far
> Macro Mode

> Locate on body with distal
image

v

v

v

v

v

» Symmetric body parts
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Macro Mode
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Skin Tones




Wet Surfaces. Narrow Locations.




Targeted Lighting




Perspective




So just maybe ......

Select a Digital Camera
according to your Needs
and Requirements

Who will be using the camera?
What will they be using it for?




Know your USER(S)

To thine own self be true

User Volume
- How many users?

Frequency of Use

- How often will user(s) touch the
camera?

Setting

o Clinical environment and
“remoteness”

Interface
> How will user(s) download images?

Skill Level

- How adept with technology and
imaging techniques?
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Know your APPLICATIONS(s)
What are we trying to do?

» Dermatology
> Skin and associated lesions

» Primary care
> Skin, wound, burns and x-ray imaging

» Dental and ENT

o Intra;]— oral imaging of moist mucous membranes and
teet

» Surgery

> Skin, blood, and moist anatomical landmarks such as
vessels, nerves, organs, etc. o
» Pathology e
- Adaptation to a microscope and imaging of slides with : .
specific color and lighting needs

» While the purpose of the application is usually
for diagnosis and treatment, there may be
another purpose that guides your selection,
such as quality assurance or documentation.




ESTABLISH
REQUIREMENTS

How will these decisions affect testing and
other processes?




Requirements

» Image Quality » Ease of Use » Video Capture
» Macro » Size /| Format » Cost
Capability » Power System » Reliability
' [:Zm. r/‘ . » Image » Advanced
Transfer Features
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How will | test cameras to
meet these requirements?

Image Quality

» Subject
- What will you be taking pictures off? Skin? Blood/Wet?
> These should be your test subjects.

» How important is detail versus color accuracy?
- Color quality is influenced by lighting

> Image detail is related to resolution, compression,
lighting, focus, clarity, and motion artifact.

» Can you say anything about pixels?
- What kind of display - and resolution? e.g. 1024x768
> Will you print out images?
- What size? - think 200-300 ppi,
- 50K Pixels per square inch 2 5x7 in = 35 * 50k = 1.8 MP
- What level of zoom (i.e smallest object in image field)?

““““““
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How will | test cameras to
meet these requirements?

Macro Capability

» How often will “macro” be required?

» What is your minimum area you need to
image?
- How close does the camera need to get to the
subject?

» Does “macro” need to be easy to turn on/off?
- Should macro mode persist after power cycle?

AFHCAN |




How will | test cameras to
meet these requirements?

Flash / Lighting

» What is the lighting in your clinic?
- Type of “bulbs (temperature or wavelength)
- Incandescent, Fluorescent, Full Spectrum, Daylight
> Intensity - bright or dim?

» Will lighting vary or will it be constant?

» Can you “condition” the lighting?
- e .g add accessory lights, change bulbs.

» Do you expect to use flash?
- Do you have “confined clinical areas of interest”?

. \xf%f%




How will | test cameras to
meet these requirements?

Ease of Use

» What are the capabilities of the user(s)?
- How many users?
- Do they have experience with specific makes/models?

» What features will be most often used?

- Most Important. Make sure these are readily accessible
and “testable”:

- On/Off, Auto Mode, Video Mode, Macro Setting, Flash
Settings, Settings Menu, Image Review, and Image Delete

> Less Important

- Viewfinder, Zoom, Setting the timer, LCD display options,
Attachment to a tripod.

» What level of training can you provide?
First impressions can be misleading.

““““““
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How will | test cameras to
meet these requirements?

Camera Size, Format

» Physical size of camera
- Small is not always good.

» Uniqueness
- Color choices help

» SLR vs Point-and-Shoot

- Simplicity versus features, control, and cost
- Interchangeable lenses
> Through the lens metering (e.g Nikon 990)

AFHCAN |




How will | test cameras to
meet these requirements?

Power System

» Are there specific needs for charging system?
> Charge while attached to PC through USB cable?
> Charge through Docking station?
> Run on external 120 VAC (e.g. microscope attachment)
- Do you want to extract batteries to charge them?

» Are there reasons to care about the type of

battery?
> Custom rechargeable versus AA rechargeable versus
disposable

» How many photos need to be captured between
charges?
- Portability issues: # patients, # images/patient

““““““
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How will | test cameras to
meet these requirements?

Image Transfer

» Are there specific needs for the storage
media?
- Ease or insert/removal, Availability, Physical size,
Capacity, Speed, Universality, Compatibility

» Are there specific needs for data transfer?

- Removable media, USB, Docking Station, WIA, WiFi,
other.

» Are there specific needs or limitations
depending on the computer application?

i \xf%f%




How will | test cameras to
meet these requirements?

Video Capture

» How often will this be used?

» Do you require specific characteristics of the
video clip
> Maximum duration
> Video Quality and high fps (maybe even high def?)
- Compression and File Size
> Sound quality

» Video Format, Licenses, and version.
> QuickTime, Windows AVI, etc.

» Additional Features
- Change zoom or focus while recording?

. \xf%f%



Cost

consider
all the
Ccosts

with

a digital
camera

\

/Carefully A

associated

purchasing

4
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How will | test cameras to
meet these requirements?

Base Cost

Accessories

Storage media

Docking station

Camera case

Tripod

High power or spare batteries
Battery charger

Lenses

External Flash

Cables

Telemedicine software
Training and Support
Warranty and Replacement

o o o o o} o o o o
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How will | test cameras to
meet these requirements?

Reliability

v

... of digital camera
- Google for known issues

» ... of manufacturer
... of distributor

v

... of purchasing process
- Availability
- Check when first available.

v
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How will | test cameras to
meet these requirements?

Advanced Features

» Can you live with most or all of the auto/default
settings?
- Does “Auto” mode provide sufficient control?

» What will you be able to compensate for?
> Need to determine this prior to testing.

» What settings can be retained when you turn the
camera off and back on?

» How do the advanced settings affect image
quality?

» What are the best settings for your clinical needs?

> Will you need to pre-program settings for a “Program” or
“Manual” mode?

““““““
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Digital Camera: Advanced Settings

Color Mode (Saturation) LOW COLOR

Face Detect Capture OFF

Exposure Metering CENTER SPOT
AF Zone CENTER-ZONE
Maintain Settings FLASH - NO

WHITE BALANCE - YES

ISO SPEED - YES

COLOR MODE - YES
SHARPNESS - YES
EXPOSURE METERING - YES
AF ZONE - YES

Orientation Sensor: Still OFF
Digital Zoom OFF
Video Size HIGH QUALITY

g - L 7y
‘_-—-',_\_, ’ /' " LY - -
~ O N : .
. / H wiE
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Requirements meet Users

Image Quality +++ ++
Macro Capability ++ ++
Flash/Lighting - +
Ease of Use - + 4+
Size / Format —~ +
Power System —~ + 4+
Image Transfer - 4+
Video Capture o _
Cost - ++
Reliability + -4+

Advanced Features +++ _

AFHCAN |




Market Review

What you do once you know your
requirements




MARKET REVIEW » Read

> |nternet
o Emails

[ What’s out there? } » Talk

> Local camera

store
o Other users
» We like: ’ T?’
) o r
- Manufacturer web sites Ox stores
_ _ > Friends,
o WWW.imaging-resource.com colleagues

(0]

www.neocamera.com
www.dpreview.com
www.myproductadvisor.com/mpa/home.do

o

o

5%
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Testing

Working towards a purchase decision.




Mimic the Clinical Environment

» Use a clinical environment (light, etc)
» ... with clinical subjects

» ... with clinical pathologies

» ... with end users

» ... with eventual camera settings !

» Require careful planning, analysis, and tools.
» Document and capture information.

ST
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Steps in Testing Cameras

» PLAN

- Get ALL your test cameras first.
> Standardize cameras settings.
- Play with each - to determine options and settings

- Use “AUTO SETTINGS” unless otherwise justified.
- Low compression? Flash auto? Image size?

> Develop a Test Plan
- Determine “typical images” - where, what, how?

- Plan for photographic subject, camera settings, and
environment for each test.

- e.g. Full face, macro off, flash auto, no zoom, fluorescent
lighting, blue background.

» EXECUTE: Take pictures
- Transfer, label and file.

» ANALYZE

AFHCAN |



Digital Camera: Image Testing

= = B
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» Multiple objects

- Hand, Face, Torso, Wound
» Backgrounds
» Distance to Object
» Lighting

- Incandescent, Halogen, Fluorescent
» Camera Settings:
- Flash on/off

- Macro on/off
- Image size and Compressions

» Force operator errors




Testing Image Quality

» Begin with default setting on all

. cameras
Hint - Make sure settings are not terribly

o different

nce you

have a “Gold » Take photographs of the same

§Ft{z?§'rirr?ce9f subjects under the same lighting
conditions

Camera, you

can test new » Compare the images side by side
cameras

against those » Rate each image for
images o
< > Colo_r
> Detail
> Ratings are made relative to the

AFHCAN | | 40 \%




Record For Each Test Image ...

» Image Resolution » Background

(Megapixels) » Lighting

» Compression Setting » Distance to Object

» Flash Setting » Object Description
» Flash Fired? » Subject

» Flash Level » Camera mounting
» Optical Zoom Setting system

» Macro Setting




Analysis Methods

» Requires Scoring and Prioritization
- ... of what’s important

» Image Quality
- Objective (quantitative)
- Image Detail (1 to 4)
- Image Color (1 to 4)
- May need to prioritize subjects or camera settings
- e.g. always use (or don’t use) the flash

» Other Requirements
> Subjective or Objective
- “Must have” versus “Nice to have” versus “Cute”

ALy €O
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Analysis Tools

How do we compare images from many
different digital cameras?




Measuring Color and Detail

A) Canon A640 (Highe...

i F) Kodak CBZ5 (Highe... [- |[O1[X]

J) Niken S7¢ [7M High.

) Nikon L1 {Highest

D) Fuji E900 (9M,

#h [) Nikon L5 (5M High,

AEE

|B) Casio EX-Z1000 (7M. Fine) 4.0 MB 3648x2736

364852736 pixels

24 BPP  [100%

~Zoom
‘ v Felative [100 KN v|  Zoom=100 | Redload |

a00xE00 | 1024x768 | 1280%1024 | 147221104 | | |

[9.52 Megapixel
Select Study
Frevious |

Type to search

» Detail of an
image is
difficult to
assess

» Need to
compare
images side by
side

» Need to be able
to zoom in

44




4% Study 7. Burn, Hand on Blue Cloth, Quality:High, Distance:, Flash:On (10 images)

AFHCAM  File Edit Miew Animation Image Color  Preferences  Window

i A) Canon A640 (Highe. .. |- |||:||L| {h B) Casio EX-Z1000 (7...

f E) Fuji Z3 (5M, Fine) ... [= |L|[><| 4!!- FI Kodak CB75 (Highe...

s = 51

| hC) Fuji ES50 (12M, Fi..

[_]L||><| 5 D) Fuji E900 (9M, Fin., L|||:|||><|

|-][_|-i'><| lﬂ!- 1) Nikon L5 (5M High,.. Llll:ll[i(l

|B] Casio EX-Z1000 (7M. Fine] 4.0 MB 3648x2736

- Resize

—£0o0m

¥ PRelative |1|]|] lI_J _b! Zoom=100 | ReLload I

|3648x2736 pixels

|24 BPP  [100%

B00xEO0 |

1024« 768 |

1280 %1024 |

147221104 |

19.52 Megapixel

—Select Study-

Presvious |

74 start ELrEP PO TE® -

Type to search 5)
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4% Study 7. Burn, Hand on Blue Cloth, Quality:High, Distance:, Flash:On (10 images)

AFHCAM  File Edit Miew Animation Image Color  Preferences  Window

i, A) Canon A640 (Highe... 'X| i B) Casio EX-Z1000 (7...

4, E) Fuji Z3 (5M, Fine) ... il F) Kodak CB75 (Highe... [~ |[O01][X] 4t

it 1) Nikon S7c (7M High...

%

IC] Fuji ES50 [12M. Fine] 4.2 MB 404813040

|4048%3040 pixels |24 BPP  [100%

—£0o0m " Resize

¥ PRelative |4|]|] 4| I bi Zoom=100 | ReLload I

BO0xEO0 | 1024 7RE |

1280%1024 | 1472x1104 |

111.74 Megapixel
—Select Study

Presvious |

‘4 Start E L EPR « Prr-mls @G

F
s Type to search 5)

E % __|:;:':’] " E - .,

o [T 944 4M




Example of Detail Scoring
Hand, Flash.: On, Distance: 10 in

> =
= =
[ '. - i
L T——
R

Detail Score: 4 Detail Score: 2

= >
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Example of Color Scoring
Hand, Flash.: On, Distance: 10 in




Flash Off
Cadaverish

Flash On
Redish

49



Kodak V1233 White Balance Settings

Fluorescent




FLASH OFF

FLASH ON

The Impact of Flash

SonyDSCW200

FujiF40

51



Impact of Flash

Kodak V1003
- Incandescent Lighting & Flash Off and On -

Kodak V1003 Leg Birthmark
Macro
Flash Off
Incandescent Lighting

4
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Kodak V1003 Leg Birthmark
Macro
Flash On
Incandescent Lighting

4

52



ATA Guidelines

I I I O I
. Optiona
t e MERICAN AEDICINE AS OCIATION'S \
O . . OWard ACTICE GUIDELINE FOR TELEDY ERMATOLOGY |
.
p t I m S Elizabeth Nu;-unt.\ i'll‘) Anne Bl!ldl\k MD, ?\“'H Hon |’.\k Mll John Bocachica MU . ‘
Lucivs Earles, MD’, Karer son, MD®, Marc Goldyne MDY, Tom Hirotd l)l)" Joseph \
e Wvedar, MD. Kare i, MPH®, Dennis O A, Dan Siegel, MDJ: N \
. r m Anonict i " . Mh" Ui Cama'. Pas By o . Richard |
r aCt I O g y akalar. o Richard B | Kimet, PhD"", PEter o vk, MSBME", Brian € ‘

a _I'hh" sandra Petel 1‘1 'lY' Lyane Rosenth: A%, Scott Simmons. Ms% Jordana |
Bemard " Jonathan L inkod:

! Arizona Telemedicine Program Yniversity of Arizona, Tocson. / AZ |

* pssociate D mn\ Tetemedicine 3 and Clinical Outreach Miller School Medicine University of |

Miaini. '\\\\nn |

lm\'d Jnformation Technology Group Telemedicine and Advanced Technology \
el

.
b. Tech :
a . g .h(vum,l—l Detrick, MD \
e C I f I C t . ‘np.uumnwnm logy and Teledernd ology Alaska Feder® Health Care Acaess \
ations ‘ ’

atology Depariment of Medicine Mi. Sinar Hospital € hicago. 1L |
lk.\um\m of Der jogy University of Missourt Health Care
"Deps aptme n\ of

Cotwmbia MO
L'm\u\ul\ ol C .llmvum\ml ANCISCO, San FranciscO. CA !
Army Medicd J Center & Depd arument of Derm aology F |

ervices Mad
et (‘n]l-nh‘! \\nlu.nk Uniformed gervices University of Health Sciences, |

ICenes for & nnmuu\ HL alth Pariners HealthCare System, 1< Department of Dermatolog¥ |
H‘m ard Medics |, Boston, MA 1
19 ghey Clime De ‘wumv. atof Dermatd 2y Burlingtot. MA & Department of Dermaiology \
Harvard Medic ‘mhmn B‘\lnn MA |

/F/as/;- The diai
L€ digital camera may haveﬂh
as

Capabﬂﬂy If it d

flash out oes, It Is recom

¢ put be adjusted to avoirgi\?;lsehd that the |
out of

(:IC)S;GE Ljr) I
mages. D
washout occurs. o not use the flash if

AFHCAN]




l( Subject | Flash Effects

Parallax }
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Impact of Color Settings
Kodak V1233 Flash On

High Color Natural Color

Low Color

55




& Mormal Quality, Flouroscent Light (Room) . Flash: Aute, Color Chart
AFHCAM File Edt View Animaion Imags Color Prefersnces Window

 Sony FD-90 (255,845 Bytes) [_ oI x]

1

Macbeth ColorChacker® Color Rendition Chart

ff, Dlympus £3030 (694,251 Bytes) N ] | 1S

HE EE
HTE EE
H EN

HEN

Macbeth ColorChecker® Color Rendition Chart of

[Sony FD-90 (255,845 Bytes) 4721104 48RP [T00Z 4875264 bytes
Zoom Fiesi
’7|7 Relative [100 Al »| _Zoom=100 | _ Reload | | ’V 800x600 |  1024w768 |  1280w1024 | 14721104 | |

AFHCAN |

Considered a “standard”
for color calibration

Good for estimating
color saturation

Limited usefulness in
determining if a camera
will provide accurate skin
tones
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Measuring Color Accuracy

» Some cameras are better than others at color
reproduction.

» A single camera will produce various color
hues depending on the basic camera settings.
- Needs to be tested with, for example, flash & macro

» ... ahd also depending on the advanced
camera settings (e.g. Kodak color settings)

» Camera behavior may change under different
lighting conditions
> Fluorescent or incandescent or sunlight or ...
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Image Detail: Compression

Casio Exilim

Compression Settings Have
ini age Detai




Image Detail: Pixel Count
Hand, Flash. On, Distance: 10 in




Features and
Ease-of-Use

Why does taking a picture feel seem as
complicated as landing a passenger jet?




Ease of Use

» Can the end-user understand the controls
sufficient to take good pictures?

> e.g. What are the training requirements?
- @.g. Can it easily take high quality macro images?

» Topics to consider:
- Macro Mode
Flash
Size
Batteries and Power Charging
Image Transfer
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Why Macro?

... allows for closest approach to subject

Kodak V1233 with Macro Kodak V1233 without Macro
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Why Macro?

... allows for closest approach to subject

Kodak V1233 with Macro Kodak V1233 without Macro

63




Macro Access - Easy

Macro Button (On/Off)
Sony Mavica FD90
> j Kodak Z885

¥  PROGRAM
e @®

Macro Toggle (On/Off)
Sony DSC-W200
Nikon Coolpix 3100
Canon A640

Fuji E E550, E900




Macro Access - Most Difficult

r ~N

Macro Button with ¥2 zoom
Nikon Coolpix 990

Press Menu Button, then choose

Shooting Mode, then chose Close Up | e i |

HP Photosmart 747 Theatre

Landscape

Use when the subject is closer than 1
meler.

fiﬁ-?
N
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Testing Macro Ease of Use

Ask an innocent
bystander to put |
the camera into e | [

v Close-up
1 3 | : N B Theatre
I I l aC ro I I I O e " ' i Landscape
i 1 Use when the subject is clos
meler.

} ™ Shooting Mode

— -
P Photosmart

N/ PROGRAM
p—— \ -

Great Idea! This is
not just for macro ...
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Trends for 2010
- — Auto Macro - -

Canon Casio Fuji Kodak Nikon Olympus Panasonic Pentax Samsung
SD3500 FH100 F80EXR M580 S8000 7040 DMC-ZS5 H90 HZ35W
Yes, Yes,
Auto Macro Yes But Yes Yes But Yes Yes Yes Yes
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Batteries: Power to the System

AFHCAN |

» Rechargeable vs Disposable

» Standard vs Propietary Form
Factor (Shape)

» Battery Technology
- e.g. Alkaline, LiMH, NiCad, NiMH,

Examples of AA Batteries
Ni-MH Battery Pack, Ni-MH,
and Alkaline

» Charger Options
> Docking Station
- USB Cable
- AC Adapter
- External Charger

» Don’t ignore Power
Consumption

Examples of
Lithium lon
Batteries for
Casio, Kodak and
Sony Cameras




Docking Station (Camera Cradle)
» ADVANTAGES

- Batteries always charged
> Images easily moved
- Camera in known location

> No battery charger or USB
transfer cable to lose

» DISADVANTAGES

o Additional cost

- Mounting and cable
management

> Confusion: Which
direction to place camera?
Potential for damage?

o Limits choice of camera
Difficult to find info

Camera and docking
stations for Kodak V1233,
Sony DSC-W200 and AP
Casio EX-V8 s WA
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Lessons Learned




Lessons Learned

» Have all cameras ready prior »
to shooting photos.

» Shoot photos consecutively
with cameras to capture )
same person at same day
under same conditions.

» Subjects are not always )
available other than your one
opportunity.

» Set up a table/spreadsheet of »
which photos you will shoot
with each camera.

AFHCAN'

- Testing

It is reasonable as a first run
to shoot @ 25 photographs
with each camera.

Some cameras have different
settings, so the spreadsheet
will change, i.e. “soft flash”

If you return or borrow a
camera, you may need it later
for a new photograph.

Comparing images by file
size is helpful.
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Lessons Learned

» There is NO substitute for )
testing in real world clinical
conditions.

» Consumer-grade devices
need appropriate settings for
Telehealth

- General

Reliability is difficult to
predict for devices with shelf
lives of 3-6 months

- Develop relationship with vendor
- extended warranty.

- Search the web for complaints

» Talk with your local camera

» Technology Review process
can often reveal the “optimal”
settings for a specific model
or manufacturer.

>

» Color accuracy is often the
distinguishing characteristic
between cameras.

AFHCAN'

store.

Rapidly changing technology,
e.g. digital cameras, may
require revisiting the market
evaluation multiple times
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Digital Cameras - They’re Not Just
for S&F Anymore !

A Al

- " : ]
=
=] > “ @

The video output of a digital camera can
be coupled to the secondary camera
input on a videoconferencing system.

Megapixel images can be captured and
zoomed to show high levels of detail.
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Conclusion?

» Digital cameras are constantly changing
> Last year’s winner is sometimes this year’s dud

> Plan on regular reviews - cameras are frequently
discontinued

» Important to know the user and need
- Need drives the activity; focuses the assessment

» Technology assessment is a skill

- Building upon previous experience is useful
- Keep great records

- Use consistent tools

> Share your results and experiences!
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